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The Basics 
 
Word is a page-oriented word-processing program. 
This means the program automatically determines 
where a new page begins, and leaves room for the 
top, bottom, left, and right margins. The preset (“de-
fault”) settings are page size of 8½ by 11 inches, with 
top and bottom margins of 1 inch, and left and right 
margins of 1 inch. At the bottom of the screen is the 
status line, which shows your location in the docu-
ment: page number, section, total page count, and 
cursor position (from top of the page, and line and 
column). As the cursor moves (either by typing, or 
using the arrow keys on the keyboard, or clicking 
with the mouse), the status line changes to reflect 
the position. 
 
Once Word is on your screen, you are ready to type. 
No layout, format, or design instruction is necessary 
to begin. If you wish to change the settings, do so 
before you type, as you type, or after you type. 
  
When working with any computer word processing 
program, you must not hit Enter (Return) at the end 
of every line. Word wraps text that doesn't fit on 
one line onto the next line. Only at the end of para-
graphs and where blank lines are desired should 
returns be inserted. “Word wraps” automatically 
change whenever your text changes; hard returns 
must be manually removed using Delete or Back-
space.  

The Keyboard 

Several keys on the keyboard have purposes specific 
to Word. The keyboard consists of four components: 
the alphanumeric keys (like a typewriter), the cursor 
movement keys (the arrows) and accompanying key 
functions, the numeric keypad (similar to a pocket 
calculator), and the function keys. 

The Screen 

At the bottom left of the screen is the status line 
showing your page, section, page count, word count, 
and more (right click to select your choices). Use 
your right clicker to expand the options. In the lower 
right corner are “View” buttons and zoom features. 
 
At the right side of the screen is a vertical scroll bar 
for moving up and down. Moving with the scroll bar 
does not move the cursor location. The scroll bars 
can be used three different ways. You can click on 

the arrows to move line by line, you can pull the box 
(“elevator”) on the bar to go to the top or bottom of 
the document, or you can click on the blank area to 
move screen-up or screen-down (or left or right).  
 
At the bottom of the scroll bar are two double-
arrows; these are “page up” and “page down” com-
mands for moving an entire page at a time. In be-
tween is a circle which provides alternate “go-to” 
shortcuts. 
 
The top of the screen is divided into two parts: the 
quick access toolbar and the ribbon. The top line, 
next to the round Office Button, shows you com-
monly used operations such as save and open.  
 
Below the quick access toolbar is the ribbon, which 
is divided into “tabs” of choices. The tabs show you 
“buttons” for various commands, separated into 
“groups” (such as Font or Paragraph). In the corner 
of each group, you will usually see a little boxed ar-
row, which opens a dialog window with more op-
tions. 
 
To use a feature, click it (once) with the mouse poin-
ter. For example, to turn on bold, point the mouse 
arrow at it and click the center of the “B.” To turn it 
off, click the “B” again. Some buttons have “drop-
downs” with choices, indicated by a downward 
pointing arrow; click the arrow for options. 
 
Another important selection under “View” is the 
ruler bar. The ruler shows tabs, indents, and mar-
gins—and allows you to change them. 
 
As you work, if you highlight (select) an area of text, 
you will see a faint shadow ribbon appear. Moving 
your mouse towards it makes it more “solid.” It is a 
shortcut toolbar for commonly used formats. 

Mouse Commands 

To select a particular area of text to format, use your 
mouse or your keyboard to highlight it. The basic 
mouse move to highlight is point, click, and drag the 
mouse. Don't let go of the mouse button until you 
get exactly what you want highlighted. Once you've 
released the mouse button, if the highlight is not 
correct, you have to restart. Click on any text to turn 
off the highlight. Quick highlights can be done with 
the following mouse commands: 
 
• Click — Position cursor. 
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• Click, Hold, and Drag — Position cursor and 
highlight; drag down (not over) to move from 
line to line. 

• Double click—Point at a word and click twice to 
highlight the entire word. 

• Triple click—Point at any word and click three 
times to highlight the entire paragraph. 

 
You can also highlight by pointing and clicking in the 
left margin. Clicking once in the margin highlights 
one line. Clicking twice in the margin highlights one 
paragraph. Clicking three times in the left margin 
highlights the entire document. You can highlight 
line-by-line by pointing in the left margin, clicking 
and holding, then pulling the mouse down or up. 
Other mouse commands include these: 
• Click in Left Margin—Line highlight. (Be sure the 

mouse symbol is an arrow.) 
• Double Click in Left Margin—Paragraph high-

light. 
• Triple Click in Left Margin—Document (global) 

highlight. 
• Ctrl Click—Select sentence. 
• Shift Click—“Range extend.” First, position your 

cursor at the beginning of what you wish to 
highlight. Then, point at the end of the desired 
highlight area, hold the shift key, and click. Eve-
rything from cursor to the point-position is hig-
hlighted. 

• Alt+Shift Click—Create a block (useful for tabu-
lar columns). 

Highlighting Text with Keys 

To highlight with the keyboard, hold the shift key 
and use your cursor arrows to move around. As you 
move with the arrows, the text is highlighted. To 
undo the highlight, let go of the shift key and move 
with the cursor arrow. 
 
An alternative way to highlight with the mouse is to 
click to position your cursor, hold the shift key and 
click at a second area of the screen. Everything in 
between will be highlighted for you. 
• Shift-Arrow — Highlight text 
• Control-Shift-Arrow — Highlight text word by 

word 
• Shift-Home — Highlight to beginning of line 
• Shift-End — Highlight to end of line 
• Ctrl-Shift-Home — Highlight to top of document 

from cursor 
• Ctrl-Shift-End — Highlight to end of document 

from cursor 

Inserting and Removing Text 

To type new text into text already typed, the most 
important rule is to position your cursor exactly at 
the point where the new text goes. Remember: the 
mouse is not the cursor.  
 
There are three ways to remove text. Delete re-
moves text following your cursor. Backspace re-
moves text backwards from your cursor. If text is 
highlighted, pressing any key that types deletes what 
is highlighted.  

Keypad Moves  
• Home — Move to beginning of line 
• End — Move to end of line 
• Control+Home — Move to beginning of document 
• Control+End — Move to end of document 
• Arrow Keys — Move character-by-character or line-

by-line 
• Control-Arrow — Move word-by-word (left, right) or 

paragraph (up, down) 
• Insert — Turns on “typeover” mode to replace text 

already on screen 
• Page Up/Down—Move screen by screen 
• Paragraph Breaks — Enter 
• Page Breaks — Ctrl-Enter 
• Line Breaks (same paragraph)— Shift-Enter 
• Hard Spaces — Ctrl-Spacebar (non-breaking spaces) 

Control (command) key shortcuts 
  a Select (highlight) all 
  b Bold 
  c Copy 
  d Fonts 
  e Center 
  f Find 
  g Go to 
  h Replace 
  i Italic 
  j Justified left to right 
  k Insert hyperlink 
  l Left align 
  m Indent 
  n New document 
  o Open document 
  p Print 
  q Redo 
  r Right align 
  s Save 
  t Hanging indent 
  u Continuous underline 
  v Paste 
  w Close document 
  x Cut 
  y Repeat 
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  z Undo 
  1 Single space 
  2 Double space 
  5 1.5 space 
  space Reset to normal 
  + Superscript 

  = Subscript 

  - Discretionary hyphen 
 

File Management  
 
“New” versus “Open”—Open retrieves a document 
from a disk. New starts a document. If a document is 
currently in use, “New” does not clear it from the 
screen. The first document goes into a window 
(workspace), and the new document goes in a new 
window. 
 
“Save“ versus “Save as”—”Save” stores the current 
document in the “07” format, asking for a filename 
that can be up to 256 characters in size (automati-
cally adding a 4-character extension, “.DOCX”). If the 
document has already been saved, pressing “save” 
simply resaves it with no questions asked. “Save as” 
allows you to save a document under a different 
name (change the name), creating a copy. It gives 
you an option to specify file format (such as “97-03” 
or “Rich Text Format”).  
 
“Close” versus “Exit”—”Close” closes the window 
currently open. “Exit” closes all windows and quits 
Word. If document(s) have not been saved, both 
commands prompt you to save your work. 
 

Viewing Your Document 
 
The “View” toolbar (lower right corner) gives you 
five different ways to look at your document: 
• Print Layout—Recommended. What you see is 

what you get. 
• Reading Layout—The Reader’s Digest approach, 

big print, small pages, to make the document 
easier to read (has no impact on printing). 

• Web layout—Used to convert a Word document 
into an HTML web page. 

• Outline—For typing outlines. 
• Normal—Draft mode, which means you don't 

see the page margins or breaks. 
On the Quick Access toolbar (top left) is “print pre-
view.” 

Moving Text 
 
The basic way to move text around within your doc-
ument involves a cut-and-paste operation, located 
under the “Edit” menu. To move text, first highlight 
it, then use Edit and chose the option called “Cut,” 
which will remove your text from the screen (send-
ing it to the Windows clipboard); alternatively, use 
“Copy” to make a copy of the text for moving while 
leaving the original.  
 
Then, move your cursor to where you would like to 
have the cut/copied text be placed. Use Edit to 
“Paste” the text back into your document. All follow-
ing text will move down to leave room for it. 
 
Only one section of cut text is active at any one time. 
When cut (or copied), it is stored in the Windows 
clipboard, viewable in the Task Pane at the side of 
the screen. Paste does not clear what is in the clip-
board. This means you can paste the same text over 
and over. 
 
You can also cut/copy and paste using the scissors, 
double-page, and clipboard buttons on your Home 
ribbon, or Ctrl+X (cut), C (copy), and V (paste) on 
your keyboard. 
 
Cut and paste also works across documents, and 
across programs. However, if you use “Paste Special” 
(on the Edit menu), you will find all sorts of options 
about how you want to paste your item, including a 
command to “link” to the original, so that if the orig-
inal changes, so does the copy you’ve pasted. 
 

Another way to move text is to highlight it, release 
the mouse, then click and drag the highlighted area. 
With the text highlighted, point your mouse at the 
middle of the highlighted area, click (don't let go of 
the mouse button), and pull the text to the new 
spot where you want it relocated. This is called 
“drag and drop.” 
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Formatting the Document 
 
Remember that Word is easier if you first use “View/Print Layout” and then go to “Word Options” on the Office 
Button to turn on “text boundaries” to see margins on the page. Remember the key rule in Microsoft Word: for-
mats are divided into four levels. 

 
Level What It Affects Available operations 
1. Font Cursor Position or 

Highlighted Area or 
Automatic Word Select 

Bold, Italic, Underline 
Font, Size, Super/Subscript 
Cut and Paste 

2. Paragraph Enter (return) Spacing  Bullets 
Tabs  Numbers 
Indents  Borders, Styles 

3. Section Page Layout/Breaks/Section (same as Document) 
4. Document Everything Paper size 

Orientation (landscape, portrait) 
Margins (top, bottom, left, right) 
Page numbers, Headers/footers 
Columns 

 

Reveal Formatting 

On the Ribbon’s pull-down for Styles is an option 
called “Styles Inspector.” There you’ll find an option 
called “Reveal Formatting.” This screen shows you 
the formats currently being used for whatever text 
you have clicked on. They are separated into the big 
three categories: font, paragraph, and section.  

Section Breaks 

Remember that one of the secrets to Word format-
ting is to insert section breaks (usually either conti-
nuous or next page) whenever you work with mar-
gins, headers/footers, paper size and orientation, or 
columns. 
 

Using the Ruler 
 

• Right Paragraph Indent  
The right triangle controls the right margin of the 
selected paragraph. 
 
• Left Paragraph Indent   
The square box at the left will indent the entire pa-
ragraph. When you drag it, all parts of the left move. 
 
• Paragraph Indent  
Above the square box is a triangle (like the roof on a 
house), which indents the entire paragraph except 
for the first line. 

• First-Line Indent  
At the top of the ruler (above the left house shape) 
is a downward pointing arrow, which indents only 
the first line of the paragraph (including bullets and 
numbers, useful for setting up “hanging indents”). 
 
• Right Margin  
The right edge (where the white meets the gray on 
the ruler, above the house-shape) controls the right 
margin of the entire document (or section). 
 
• Left Margin  
When the pointer sits between the first-line indent 
and paragraph indent triangles, it becomes a double-
arrow, which changes the margin of the entire doc-
ument or section. Measure the margin by watching 
the number in the gray area, not the white area. 

Tabs  

Tabs make text line up at specific positions on the 
page, such as for forms or for decimal alignment. To 
set tabs, first click on which kind of tab you would 
like: Left, Center, Right, or Decimal (the menu also 
includes “bar” or vertical bar lines). Then click on the 
ruler with your mouse to position the tab. If you 
don't like where it is, pull it with your mouse to a 
different location. If you want to remove it, click and 
pull it off the ruler. Under the “Format/Tabs “ menu, 
is a dot leaders and underlines between tabs, as well 
as clear all. 
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 Sample tabs: 
Bar> Left .................................................... Right Center Decimal.  <Bar 
 ABCDE ............................................ FGHIJKLM NOPQR 234.56 
 XYZ .......................................................... ABC DEF 1.11 
 JKLJKL ..................................................... YUOI HJKLT 789987.89 

 
If you press enter at the end of the line (start a new paragraph), you carry your tab settings with you to the next 
line. If you arrow up or down to a new paragraph (or click on a new paragraph), you leave the tab settings behind. 

Tables 

Tables are an alternative to tabs for lining text up. They are created by clicking and dragging the Table button on 
the Insert ribbon . 
 
  
  
 
This creates a series of “cells” that can contain text or numbers. If you wish to adjust the size of a column, you can 
pull the on-screen borders or adjust the “checks” on the ruler. Tabbing adds rows to the table. Tables can also be 
used to “sum” columns of numbers (you will find the fx button for formulas on the ribbon button called “Table 
Tools/Layout”). 
 

Shortcuts 

AutoCorrect 

On the Office Button “Word Options” command is a 
feature called Proofing/AutoCorrect Options. This 
function automatically corrects typos when you 
make them. Although many typos are built in to 
Word (such as “adn” to “and”), you can tell it your 
favorites. There are two steps: enter the text you 
wish to have replaced, and then enter what you 
want to replace it with. Then you “add” your entry. 
 
Under AutoCorrect Options are many other features 
that many Word users find annoying. AutoCorrect is 
where you turn off features such as automatic capi-
talization at the beginning of sentences, or set first 
and left indent with tabs and indents. 

Insert  

• Page Break—Manually start a new page.  
• Illustration—Pictures, clipart, etc. 
• Links—Hyperlinks, bookmarks 
• Header & Footer— Specify position and align-

ment for automatic numbering. Automatically 
inserts a page number into the document at the 
designated position. Also allows you to turn off 
numbering for the first page, as well as indicate 
what number Word should start counting with. 

(This will affect your headers and footers also, 
and is controlled by sections.) 

• Text—Text box, WordArt. 
• Date and Time—Inserts the current date and/or 

time at your cursor position. At the bottom of 
the window is an option you can turn on or off 
that will insert the date or time as an automatic 
“update field.” This tells Word to update the 
date whenever you next work on this document; 
you will still see the old date on the screen, but 
the current date will print. 

• Symbol— Special characters, such as 
½V½)��
�. Note that each character can 
be assigned to a keyboard shortcut (such as 
Ctrl+Alt+a). Symbols differ depending on the 
font selected. The fonts called Symbols and 
Wingdings give you the most options. Under 
“Special characters” you’ll find symbols such as 
§©®¶…—. Any of these can be assigned to a 
shortcut key. 

• Equation 

Page Layout 

• Themes—Colors and designs. 
• Page Setup—Margins, Size, Columns, Breaks 

(sections) 
• Page Background—Watermarks, borders. 
• Paragraph—Indents and spacing. 



6 Advanced Formats | Computer Resource Center, Inc

 

• Arrange—Front to back, align, text wrap (for 
objects such as pictures). 

References 

• Cross-Reference—Table of Contents—Label 
high-lighted text for inclusion in a table of con-
tents, then generate the table, with page num-
bers. 

• Footnotes—Insert footnotes or endnotes. 
• Citations and Bibliography 
• Captions—Cross-references (allows you to insert 

a link in your text to another page, heading, 
footnote, or table, so that if the target changes 
(for example, page 3 may be page 4 or 5 when 
you’re done), the reference updates automati-
cally). 

• Index—Alphabetical list of key words. 
• Table of Authorities—Legal cites. 
 
If you do not like the format Word applies to the 
results, do not try to format manually. Since these 
“tables” and “indices” are automatically updated 
(i.e., page numbers change whenever your text 
changes), be sure to make format changes through 
“Style” using the appropriate styles. 

Generating a Table of Authorities 

Marking citations for a table of authorities is compa-
rable to manually marking headings for a table of 
contents. Word looks for cases, statutes, rules, trea-
tises, and constitutional provisions to generate a 
table of authorities. You can also mark any addition-
al authority you need included.  
 
Step 1: Type your legal document, including all the 
cases, statutes, rulings, treatises, regulations, and 
Constitutional provisions that you will cite. You may 
either mark the citations as you type, or finish the 
paper and then go back through it, marking the cita-
tions at the end.  
 
Step 2: Mark your citations. Highlight the citation 
that you wish to mark. In Word 03, choose "Insert" 
on the menu bar. Navigate down to "Reference" and 
click on "Index and Tables." (In Word 07, go straight 
to References.) Choose the "Table of Authorities" tab 
at the top of the dialog box. Click on the "Mark Cita-
tion" button. Choose the category of your citation 
from the drop-down list (e.g., case, ruling, regula-
tion) and click "Mark" or "Mark All" (depending on 
whether you want to include all references to this 
particular citation in the table of authorities or just 

one instance). The following dialog box will appear. 
Click Next Citation. Word searches the document for 
terms such as: in re, v., Id., Supra, Infra, Cong., Sess., 
and §. 
 
Step 3: Click the "Next Citation" button at the top of 
the dialog box. Microsoft Word searches for com-
mon legalese such as "v." and dates in parentheses 
"(1950)." Mark each citation as appropriate. Click the 
"Close" button to return to your document. You may 
want to do a manual scan of the document to ensure 
Word correctly picked up all your legal citations.  
 
Step 4: Move your cursor to the point in your docu-
ment where you wish the table of authorities to ap-
pear. In Word 03, choose "Insert" on the menu bar, 
and navigate to "Reference" (go straight to Refer-
ences in Word 07) and click on "Index and Tables." 
Choose the "Table of Authorities" tab at the top of 
the dialog box (or “Insert TofA” in 07). Make sure the 
Category type is set to "All" if you wish your table to 
include all types of legal citations. Press "OK." Word 
creates a table of authorities using all your marked 
citations, organized by citation type.  
 
A note about “passim”: If checked and a citation is 
referenced on more than 5 pages, Word will put the 
word "passim" in place of the page numbers. If un-
checked, Word allows all referenced pages to be 
listed, no matter how many there are. 
 

Advanced Formats 

Format painter (“Home”) 

Copies a format from highlighted text, then pastes it 
to another highlighted area. To use the painter, first 
highlight the text whose format you want to copy; 
then click the painter button. Next, scroll to the area 
of text that you want to re-format in the new style, 
and highlight it. This stops the painter (it will only do 
one selected area at a time; you must re-click the 
painter to do a second area). 

Bullets and numbering (“Home”) 

Formats for how the bullets/numbers look, including 
custom bullets such as D&⌦;�. 

Drop cap (“Insert”) 

Enlarge the first letter of a paragraph and wrap text 
around it. Note that this function will not work with 
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tabs before the letter since it “frames” the first 
space on the line. 

Headers and footers (“Insert”)  

Headers go at the top of pages, and can contain text, 
date, page number, and rule line. Footers go at the 
bottom. Two page number tabs are already set for 
centering and flush right. (Important: Remember 
that headers, footers, and page numbers are con-
trolled by section breaks.) The ribbon options for this 
function have the following choices: 
 

1. Built-in (pre-set formats) 
2. Edit header 
3. Remove header 
4. Save selection to header gallery 

 
The “Insert/Page Numbers” dropdown allows you to 
choose a number location (top or bottom, margins, 
or cursor position), and left, right, center—and 
whether or not to show the number on the first 
page. Also in this window is a “Format” button, 
which allows you to tell Word to continue number-
ing a particular section consecutively from the pre-
vious section or to start re-numbering the current 
section from a particular number within the docu-
ment (useful when you have a cover page, table of 
contents, then want the third page to be numbered 
page one).  

Columns (“Page Layout”) 

This button separates document into multiple, 
newspaper-style columns. The “Format” menu for 
columns includes options for margins and a line be-
tween columns. To put columns into part of a docu-
ment, the document must be divided into “sections” 
with “continuous” breaks. 
 

Working with Styles 
 
Styles are saved formats that can be re-used. The 
important thing to know about styles is that Word 
uses them whether you do or not, and many func-
tions in Word (such as Table of Contents) will not 
work without styles. Every feature of Word has an 
assigned style, such as page numbers, headers and 
footers, footnotes and endnotes, and envelopes and 
labels. When you start a new document, you are 
already using a style called “Normal.” 
 

Styles can be edited. It is important to understand in 
Word that if you do not like what a style is doing to 
your text, don’t change the text—change the style!  
 
On the Home ribbon, the button called “Styles” ex-
pands the styles screen into a drop down. Hover 
over any to get a description. 
 
At the bottom of the Styles window are three com-
mands. One creates new styles and adds them to the 
list. The second is the style inspector, which will let 
you modify your styles. The third is manage your 
styles, which lets you remove styles. 

Editing Styles and New Styles 

Since styles are ways to store your formats for re-
use, you can either create new styles or edit (“modi-
fy”) existing styles (you can also highlight an area of 
text with a desired format, then click on the style 
box to get a menu to “redefine” the style on the hig-
hlighted text). 
• New Style—Requires you to specify a name 

(which shows on the format toolbar); a style 
type (change the paragraph or just the hig-
hlighted area); based on (used other style as 
base format); and style following paragraph (the 
next style to switch to when you hit enter). Then 
you change the format. 
• Modify Style—Change an existing style. The 

format option gives you choices to change 
¾ Font—allows you to specify font, font size, 

color, position (super/subscript), characte-
ristics (bold, italics, small caps, underline, 
etc.), and spacing (normal, expanded, or 
condensed). 

¾ Paragraph— formats specify paragraph 
alignment (left, center, right, justified), in-
dents (left, right, first line), spacing (before 
or after, or between lines), based on style, 
border (box or bar), keep together, page 
break before, and line numbering 

¾ Tabs—tab settings for the style 
¾ Borders—sets borders and shades around 

the paragraph 
¾ Language—codes text so Word will use dif-

ferent language spell checkers 
¾ Frame—creates “cutouts” 
¾ Numbering—automatic numbers 
¾ Shortcut key (assign an keyboard combina-

tion to run the style, such as Ctrl+Sh+I) 
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Unless otherwise specified, styles are paragraph 
formats, and automatically affect the entire para-
graph.  
 
The automatic setting is that a style is available only 
in the document on which you are working. If you 
wish to make a style available in other documents, 
you must add it to a template; then you will have 
access to it any time you are working on a document 
based on that template. 

Changing Your Default Format 

To change your automatic (default) type format in 
Word, use “Styles” to redefine your “normal” style. 
Be sure to check “New Documents based on This 
Template” so it is saved. 
 

Graphics 
 
On the Insert tab of the Ribbon, Word gives you 
commands to insert  

• Pictures—photographs, inserted from files, 
which can then be sized, and formatted inv 
various ways. 

• Clip Art—free artwork from Microsoft, in-
cluding cartoon, animations, photographs, 
and sounds, most on-line (must be down-
loaded to use) 

• Shapes—graphical shapes (such as stars and 
boxes) which can be used to hold text 

• SmartArt—specially designed graphical dis-
plays for showing lists, processes, hierar-
chies (such as organization charts) 

• Charts—graphs based on data, entered into 
an Excel spreadsheet, but embedded into 
Word. 

 
Once you have inserted any form of graphic, you can 
then edit with tabs that appear for Design and For-
mat. 
 

SmartArt  
 
SmartArt is a new way to present information in a 
visually appealing way (I hope), without resorting to 
bland bullets or boring lists. It works consistently 
across Word, Excel, and PowerPoint. You begin by 
using the Insert tab on the ribbon, where you find 

SmartArt listed in the Illustrations group. Clicking it 
brings up a selection of SmartArt types, including 
List, Process, Cycle, Hierarchy, Relationship, Matrix, 
and Pyramid, each with a variety of formats. Select 
one to insert the SmtartArt skeleton into your doc-
ument. This automatically adds two new tabs to the 
ribbon: Design and Format.  
 
At the left of the SmartArt is a text-typing area which 
can be closed (X in the corner) or opened (double-
arrows on frame). Press enter to create a new level; 
press Tab to indent or create a sub-bullet. When 
formatting and designing, note that many of the 
selections can be “previewed” by pointing your 
mouse at the option (but don’t click). 

Manipulating smartart 

Selecting: To manipulate a SmartArt object, you first 
select or highlight it.  To do this, simply 
place your pointer anywhere in the graphic 
and click once. Graphical “handles” should 
appear on the edges. 

Moving:  With the object active, point the mouse at 
the frame or border outlining the graphic, 
then click and drag, moving the mouse, and 
the chart moves with you.  

Resizing: To enlarge, shrink or change the shape of 
the object, place the pointer on any of the 
“handles” on the frame until the pointer’s 
shape changes into double-arrows, then 
click and drag. The outline you draw will 
change the chart accordingly. Corner han-
dles enlarge and shrink. Many of the com-
ponents of a SmartArt object also have 
handles, which can be stretched and pulled 
to re-size that part of the graphic. 

Formatting: Clicking once on a SmartArt object will 
allow you to move it or change its dimen-
sions.  But you may want to change other 
aspects as well. One option is to click once 
on any specific part of the chart, then right-
click with your mouse to find “change” and 
“format” options. Alternatively, you can use 
the ribbon tabs, as explained below. Re-
member to click the Home tab for simple 
formats (font, size, center, color). 

Deselecting: After completing your changes, simply 
“Click Away” –  click any where in the doc-
ument outside the object. 
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Design 

Create Graphic 
• Add Shape — Opens the dialog window that 

allows you to select the kind of chart you 
wish to have (column, line, pie, bar, area, 
XY, stock, surface, doughnut, bubble, ra-
dar). There are multiple designs for each 
chart type; for example, for column charts, 
there are side-by-side, stacked, percentile, 
and front-to-back. 

• Add Bullet — Adds either another entry of 
the same level within the hierarchy, or a 
sublevel. 

• Right to Left — Aligns content on the right 
instead of the left.. 

• Layout — Saves an edited chart as a tem-
plate, so it can be re-used. 

• Promote/Demote — Indents and unindents 
bullets and levels (same as Tab and Shift-
Tab). Turns a main level entry into a suben-
try, or a subentry into a main entry. 

• Text Pane — Activates the text-typing box. 

Layouts 
This option allows you to switch from one 
SmartArt design into a different one, for ex-
ample, from 3 horizontal boxes to 3 vertical 
boxes or to a pyramid. 

SmartArt Styles 
• Change Colors — Select new color combina-

tions (based on Theme colors) for the 
conte.t 

• Effects — Various designs you can select to 
create 3-dimensional or shaded effects 
(note this is one of the features where you 

can preview by pointing your mouse at an 
option without clicking). 

Reset 
Cancels any formatting changes you have 
made and restores the SmartArt object to 
the original format. 

Format 

Shapes 
Impacts the shapes within a SmartArt ob-
ject. You can change the shape (switch a 
box to an arrow), or make the shape larger 
or smaller. 

Shape Styles 
Predesigned or custom fills, outlines, and 
effects for the components of the graphic 
(such as fill colors or borders or shadows). 

Word Art Styles 
Predesigned or custom text formats (includ-
ing text color, text border, and text effects 
such as glow). 

Arrange 
Bring to front or send to back (used when 
there are multiple objects embedded within 
a chart. 

Size 
The horizontal and vertical dimensions of 
your chart. This is an alternative way of siz-
ing, as opposed to dragging handles. 

 

Templates 
 
Just as there is never a time in Word when you are 
not in a style, the same is true of Templates. Tem-
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plates are pre-formatted documents that can be re-
used. They hold the paper size, margins, head-
ers/footers/page numbers, columns, and styles. Any 
time you select a template, you automatically get a 
new document. 
 
Word supplies a large variety of built-in templates. 
You activate them by using the “New” command on 
the Office Button. Choosing a template creates a 
new, unnamed copy of the original’s content on your 
screen (which many people erroneously try to do by 
using “Save as”). 
 
To make your own templates, create a document as 
usual. Instead of saving it as a document, when you 
press Save, change the file type to read “Word tem-
plate.”  
 

Envelopes and Labels 
 
If you need to print an envelope or label as part of a 
letter, you do not have to highlight the address un-
less there is more than one. Go to “Mail-
ings/Envelopes and Labels.” 
 
Under Envelopes, you will have a dialogue box that 
should automatically show the mailing address from 
the letter. There is an optional return address that 
can be omitted by clicking the “omit” box. There is 
also an address book for storing and re-using ad-
dresses if Microsoft Outlook is installed on your sys-
tem. 
 
Under Envelope/Options, you can specify what size 
envelope to print, and what font and position to use 
for the addresses. Then you can decide whether to 
print the envelope straight to the printer, or add it to 
the letter to save it for future use. 
 
The Label window is very similar. However, at the 
bottom of the window are two other options: print a 
full page of the same address (a sheet of labels to 
the same person), or print one label on the page (to 
re-use a partially used set of labels, which requires 
you to specify which column and row on the sheet to 
use). You can specify the label format through the 
Options button. 
 
 
 

Mail Merge  
 
Mail merge is the ability to generate multiple letters, 
envelopes, labels, or emails, or to generate a “direc-
tory” from one list of data. To start a mail merge, go 
to the Mailing ribbon, and click on “Start Mail 
Merge.” The mail merge task pane will appear on the 
right side of your screen. There is also the “merge 
toolbar” across the top of your screen.  
 
Mail merge is a “wizard”; there are 6 steps to com-
plete the merge. Step 1 is to select the type of doc-
ument you are trying to create: letters, email, enve-
lopes, labels, directory (a directory used to be called 
“catalog” and compiles a formatted list from the 
data). Select the one you wish to do; you can only do 
one at a time (radio button). Then click at the bot-
tom where the screen reads “Next: Starting docu-
ment.” 
 
Step 2 is “Select a document.” You can use the cur-
rent document (whatever is currently on your 
screen), use a pre-existing template, or choose a 
different existing document (open a file). Select one, 
then click on “Next: Select recipients.” 
 
Step 3 is where you specify where your data are 
coming from. You can use an existing list (click on 
“Browse” to locate a preexisting list, as long as it is 
either a database .MDB file, an Excel .xls file, a Word 
.doc file, or a delimited .txt file), select from an Out-
look address book (“Choose Contacts Folder”), or 
type a new list (“Create”). If you click “Create,” you 
will see a data entry screen where you can type your 
information; this screen is designed to match the 
other steps of the wizard; if you choose not to use 
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